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Introduction
NoteWorthy Composer is a music composition and notation processor for
Windows. It allows you to create, record, edit, print and play back your own
musical scores.

Installation
NoteWorthy Composer is installed using the installation program on the CD.
Place the NoteWorthy Composer CD in your CD drive, then open an Explorer
Window to view the contents of the CD (on most systems this will be
automatic).

Windows 3.1 and Windows for Workgroups Users: To install NoteWorthy
Composer, go to the Setup folder on the CD, Run the file nwcset16.exe to install.

Windows 95 or later Users: If you are using Windows 95 or later (this includes
Windows 95, 98, ME, NT4, 2000 or XP), you should be able to install by
clicking the NoteWorthy Composer icon on the initial screen that is loaded
automatically when you insert the CD. If this screen does not appear, to install
NoteWorthy Composer, Run the file autorun.exe.

If you already have NoteWorthy Composer installed:
It is recommended that you uninstall earlier versions prior to installing the new
version. You can see what version you have installed by going to Help: About in
NoteWorthy Composer. You can remove an existing version using the uninstall
utility installed with that package. Once you have removed the old version,
install the new version of NoteWorthy Composer from the CD. If you want to
keep multiple editions on your computer, you should install this new version
into a different directory. Do not run older versions at the same time as this new
version.

About the User’s Guide
This user’s guide is designed to cover the basics of NoteWorthy Composer and
will help you create scores like a pro in no time.

It is assumed you have a working knowledge of the Windows interface. If you
do not feel comfortable with Windows, you may want to review the Windows
help file, documentation and/or tutorial.

In this user’s guide, the left mouse button is considered the primary (most often
used) button. If your mouse is set up differently, please be aware of this fact.
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When 2 or more of this symbol  are listed together in the user’s guide, it
means there are several different ways to accomplish the same task. Only one of
the methods needs to be performed to complete the task.

Learning More about NoteWorthy Composer
This user’s guide is intended to be a supplement to the information available in
NoteWorthy Composer's Help file (F1). If you want to learn about a specific
command, press F1 while the command is highlighted in the menu. For
example, to learn more about how to enter lyrics, click on the Edit menu, move
the mouse over Lyrics and press F1. In addition to a description for each
command, the Help file also includes some general topics. Just click on the
Help menu for a listing of topics

You can access topic-specific assistance by clicking the Help button in dialog
boxes. If you are using the 32 bit version, specific help can be accessed by
clicking the “?” at the top of dialog boxes and then clicking an item in the dialog
box for more information.

Each time you open NoteWorthy Composer, a Did You Know? dialog box will
appear providing a new user tip. These tips can also be accessed from the Help
menu under the Did you know… command.

Another way to learn the capabilities of NoteWorthy Composer is to use the
sample song files. These songs are in the Samples folder and can be accessed
with File: Open. By playing, previewing and printing the files, you can get an
overview of the product. If you see a symbol in a sample score that interests
you, select (highlight) it and press Alt+Enter to open the dialog box for the
symbol. Once the dialog box is open, click Help for more information.

Lastly, if you have Internet access, our web site has several areas that are helpful
in learning and using the product. For example, the “User Tips” page contains
creative ideas from users. The “NoteWorthy Composer Forum” provides an area
for users to post questions and comments for other users to read and issue
responses. Our web address is http://noteworthycomposer.com.

Shortcuts to Using NoteWorthy Composer
Most note and symbol entry in NoteWorthy Composer can be done from the
computer keyboard with quick keys. There is a list of quick keys in the Help
menu under Keyboard Reference. Once you learn the shortcuts, notating will
be faster than using the menus and the mouse.

NoteWorthy Composer uses many of the same editing keyboard shortcuts as
word processors. If you are not familiar with these shortcuts, the instructions
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below will be helpful. You may want to practice these techniques on one of the
sample songs provided with NoteWorthy Composer.

Moving Around in a Staff: To move the insertion point one item at a time, use
the ←→ keys. To move one measure at a time, use Ctrl+←→. While working in
a staff, pressing the Home key will take you to the beginning of the staff and the
End key will take you to the end of the staff. When you add Shift to the key
combinations, the items will be selected as you move.

Selecting: Some actions in NoteWorthy Composer can be performed only after
items have been selected. For example, cut (Ctrl+X) and beam (Ctrl+B) cannot
be executed until items are selected. Once an item is selected, it will appear
highlighted with a different background color. To select an item(s):

Mouse selecting - Click the left mouse button and drag over the item.

Keyboard selecting - Place your insertion point to the left (or right) of the
item, hold down the Shift key while pressing the → (or ←) key to
highlight the item. Holding the Ctrl key at the same time will select the
entire measure. Shift+End selects to the end. Shift+Home selects to the
start.

Deleting: An item can be deleted by placing the insertion point to the left of the
item and pressing Delete or by placing the insertion point to the right of the item
and pressing Backspace.

Moving Around in the Score: Pressing Page Up will activate the staff above
the currently active staff. The insertion point will be moved to the new active
staff. Page Down will activate the staff below the currently active staff.
Ctrl+Home will activate the top staff while Ctrl+End will activate the last
staff.

Support for NoteWorthy Composer
For support in using NoteWorthy Composer, you may contact us via:

E-mail support@NoteWorthyComposer.com
Web http://NoteWorthyComposer.com
Postal Mail NoteWorthy Software, Inc.

PO Box 995
Fuquay-Varina, NC 27526-0995
USA
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Notating “Jingle Bells”
The purpose of this section is to help you become familiar with how to enter a
score from start to finish by notating the song “Jingle Bells.” The focus is on
note and symbol entry, with some music basics. The final score is in the
Samples folder as file jingle.nwc. In addition, a printed copy of the song file is
shown on page 5 of this user’s guide. While working through this section, it may
be helpful to have the file jingle.nwc open as a reference. Use File: Open to
access the song file jingle.nwc in the Samples directory.

Creating a new file
To start, you will need to create a new song file. It will be used to notate the
song “Jingle Bells.” To start a new song file, do one of the following:

 Select the File menu option and New.
 Click the New File  icon.
 Press Ctrl+N.

Once you have started a new song file, the Song Templates dialog box will
appear. There are several song templates to select from, but we will start a song
from scratch. With <Blank Score> selected from the General tab, click OK to
start a new empty file. (For more information on Templates, see page 28.)

Next, the File Info dialog box is presented. This area allows you to enter
information about the song. The title, author and copyright information entered
in this dialog box is used when printing the song file. Enter Jingle Bells for the
Song Title. The copyright information will be entered in for you. Any of this
information can be changed if you wish. The Comments section is where you
can add any extra information about the song. If you like, type in: My notation
of Jingle Bells. Once you have entered the information, select OK.

Note: You can always change the song information in this screen at a later date.
To access the File Info, do one of the following:

 Select the File menu option and Info.

 Click the Authoring Info  icon.
 Press Ctrl+I.
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“Jingle Bells” Notated with NoteWorthy Composer

Jingle Bells

Copyright © 2000 by NoteWorthy Software, Inc.
All Rights Reserved

Jin - gle bells, jin - gle bells, jin - gle all the way,
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Adding, Naming and Connecting Staves
After clicking OK in the File Info dialog box, the editing screen will appear
with one staff. “Jingle Bells” has two staves, so you need to add another staff.

To add another staff, use one of the following procedures:

 Select the Staff menu option and New Staff.

 Click the New Staff   icon.
 Press Ctrl+A.

Now, the two staves need to be named. In addition, you need to put a piano
brace at the start of the two staves. You will work with the upper staff first.
Click the top staff to make it active. Open the Staff Properties dialog box by
doing one of the following:

 Select the Staff menu option and Staff Properties.
 Press F2.
 Right mouse click and select Staff Properties.

Under the General tab, rename the staff currently listed as Staff to Right Hand.
To frame the staff with a brace as in piano format, click the Visual tab and
select Upper Grand Staff as the Style. Click OK. The lower staff will need to
be set before the brace will be drawn.

Make the lower staff active by doing one of the following:

 Click the lower staff.

 Press Page Down.

Note: You know a staff is active when it is the active color and has a box around
it. The default setting for the active staff color is blue. You can change the staff
colors for NoteWorthy Composer by selecting Tools: Options and clicking the
Color tab. You can turn the box off with the Editor tab, Active Staff Frame.

Using Staff Properties (F2), under the General tab, replace the Staff-1 name
with Left Hand. To make sure the piano brace will be completed, click the
Visual tab and select Lower Grand Staff as the Style. Click OK. You should
now see the start of two staves with a brace in front of them.
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The Work Space
The NoteWorthy Composer work space is shown below.

Dockable toolbars: You will notice the Notes toolbar in a different location
than usual. You can click and drag the toolbars to the best position for you. Just
click one end of a toolbar with the left mouse button and drag it. If you drag it to
one side of your work space, the toolbar will align vertically with the side.

Customizable toolbars: NoteWorthy Composer will allow you to streamline
your toolbars to only include commands that you frequently use. To create new
toolbars or to modify existing toolbars, use View: Toolbars, Customize. Once
in the Customize Toolbars dialog box, click the Help button for more
information.

The Window: Tile command will display both jingle files in tiled fashion for
easier viewing.

As you create a song in NoteWorthy Composer, the staff (or staves) will extend
to the right as if following a time axis. When you print your song, the staff (or
staves) will be wrapped in sheet music style. For example, in the work space, to
see all of the file jingle.nwc you must scroll to the right. However, go to File:
Print Preview and you will see the staves wrapped in several lines.
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Time to Save
To preserve your work, you should save the file now and occasionally while
working on the score. To save a file, do one of the following:

 Go to the File menu and select Save.

 Click the Save File  icon.
 Press Ctrl+S.

Here you can name the file and place it in your Documents folder. Since
jingle.nwc is the original file name, you may want to save your file as
jingle2.nwc. It is best to save your song files in a different folder than the
NoteWorthy Composer program folder. You can set the default location for
saved files in Tools: Options, Folders tab.

Clef, Time Signature and Key Signature Entry
At the beginning of most songs you will find a clef, a time signature and a key
signature. You will enter these items by working with the upper staff first and
return to the lower staff later. Since “Jingle Bells” is a two-handed piano score, a
treble clef is needed in the top staff.

The insertion point plays a key role in note and symbol entry. It is the flashing
marker in the staff that determines where items will be placed. This placement
indicates where a new entry will be before and after items, as well as where it
will be vertically on the staff. For clef and signature entries, the vertical position
is not important, as the sign will be centered automatically. However, it will be
important for note entry to place notes at the right pitch. If you make a mistake
and need to delete items, place your insertion to the right of the item and press
Backspace or place your insertion point to the left of the item and press Delete.
You can also use Edit: Undo (Ctrl+Z).

To add the treble clef, make sure the insertion point is within the lines of the top
staff. Access the Clef dialog box in one of the following ways:

 Select the Insert menu option and Clef.
 Right click mouse, select Notation: Clef.
 Press the quick key C or c.

Once the Clef dialog box is open, select Treble Clef and click OK.

a
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If you are using the Insert Tool Bar, you can simply click the Treble
Clef icon to place the clef on the active staff at the insertion point.

Note: The Insert Tool Bar (which by default appears vertically along the left of
the work space) allows fast point and click entry of some common symbols.
However, you are not always provided access to the symbol’s dialog box and
possible advanced features. For example, when you point and click on the
Treble Clef, the clef is placed on the staff. However, if you use Insert: Clef, the
dialog box will be presented and you can see that you can set the octave shift
and change the color. During this tutorial, instead of using the Insert Tool Bar
you may want to use the Insert menu and look at the dialog box for the symbols.
That way, you will know what else is available if you should need these features
in future work.

Next, you will need to enter the key signature. The key of “Jingle Bells” is F
Major. To access the Key Signature dialog box, use one of the following:

 Select the Insert menu option and Key Signature.
 Right click mouse, select Notation: Key Signature.
 Press the quick key K or k.
 Click the        icon in the Insert Tool Bar

In the box, select F Major and click OK.

If you are not familiar with the key signatures, there is a chart in the Appendix
of this user’s guide.

Now, the time signature needs to be entered. The time signature is written like a
mathematical fraction which indicates the number of beats per measure (top
number) and which note gets one beat (bottom number). The sample song
“Jingle Bells” uses 4/4 time. Thus, there will be 4 beats per measure and a
quarter note is one beat. To open the Time Signature box, do one of the below:

 Select the Insert menu option and Time Signature.
 Right click mouse, select Notation: Time Signature.
 Press the quick key G or g.

In the Time Signature dialog box, type 4 in for Beats per Measure and for Value
for Beat. Click OK.

Using the Insert Tool Bar, you can simply click the 4/4 icon to place
the 4/4 time signature on the active staff at the insertion point.

a f
  

a f 44
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Note Entry
There are several ways to enter notes and you will probably try them all before
you find the style you like best. As you work with NoteWorthy Composer, you
will develop the method that is right for you. This section starts with the point
and click method and moves towards quick keys. MIDI keyboard entry is not
covered here, see page 27 for instructions.

The first note in “Jingle Bells” is a quarter note in the A position with a staccato.
The staccato mark means to play the note short, or detached. To place the first
note using the mouse:

1. Click the Quarter Duration  icon.

2. Click the Staccato  icon.
3. Click the A position in the upper staff (the second space from the

bottom), to the right of the time signature. You should see the
insertion point blinking in the A position

4. Press Enter.

The second note is the same. To place the second note using quick keys:

1. Press the number 3 for quarter duration.
2. Press the comma ( , ) for a staccato.
3. Place the insertion point in the A position using the ↑↓ arrow keys.
4. Press Enter.

Enter the third note using one of the above methods or try your own
combination.

Tips for entering notes:

 If you do not know the action an icon represents, hold the cursor over
the icon and a tool tip will appear with the command name and, if
available, its quick key

 Icons may be on (white background), off or unavailable (grayed out). If
an icon is on, it is ready to be used. Turning an icon on while notes are
selected will perform the action represented by the icon. Turning an icon
off while notes are selected will reverse the action. If an icon is grayed
out, items have not been selected for which the icon can be used.

 To prevent auto-reset of some icons during note entry, select Tools:
Persistent Note Tools or click the       icon.
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Rest Entry
After the three staccato quarter notes, there is a quarter rest. To choose the
duration for the rest, select the quarter duration. These are the same icons you
have been selecting to enter notes. To enter the rest:

1. Place the insertion point to the right of the last note
entered.

2. Click the Quarter Duration  icon or press 3.
3. Press the Space Bar.

Remember: Enter inserts a note and Space Bar inserts a rest. The note duration
icons select the duration for both.

Bar Line Entry
At the beginning, 4/4 was selected as the time signature, meaning there will be
four beats per measure and a quarter note is one beat. So far, you have entered 3
quarter notes and 1 quarter rest, which equals four beats and makes a measure.

Measures are divided by bar lines. To add a bar line, place the insertion point
to the right of the quarter rest and select one of the following:

 Go to the Insert menu and select Bar Line.
 Right click mouse and select Bar Line.
 Press the Tab key.
 Press the * key.

Measure Numbers
You can automatically number the measures in a song to keep your place. You
may want to do this for your “Jingle Bells” file and the jingle.nwc file. To enter
measure numbers:

1. Select File: Page Setup.
2. Click the Options tab.
3. At Measure Numbers, select one of the options other than None.
4. For Measure Start, enter 1.
5. Click OK.

n
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More Notes
Continue entering notes in the next two measures until you reach the dotted
quarter note. The dot to the right of the quarter note means it gets an extra half
beat. The dot is placed in the same manner as the staccato. To enter the dotted
quarter note:

1. Click the Quarter Duration  icon or press 3.

2. Click the Dotted Duration  icon or press the period key ( . ).
3. Place the insertion point in the F position, the first space from the

bottom.
4. Press Enter.

Continue notating the upper staff through measure 6. The last two notes of
measure 6 are beamed eighth notes. The notes need to be entered as individual
eighth notes first. To beam flagged notes, select the notes and choose one of the
following:

 Select the Edit menu and Beam.
 Click the Beam Selected Notes        icon.
 Press Ctrl+B.

Note: The Beam command will not be available until you have selected notes
that can be beamed; for example, 2 or more eighth notes. If you do not
understand how to select notes, see page 3 under “Selecting.”

Special Endings and Repeats
The first ending of “Jingle Bells” is different from the final ending. Special
endings and a repeat will be used to indicate the direction of play. To enter the
special ending:

1. Place the insertion point at the beginning of measure 7.
2. Select Insert: Special Ending, press the S key or click the       icon.

6

kz kz k kz kz
7

 1.

kz kz kz kz
8

j j 9

J

kz kz
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3. Click the 1st Ending box if it is not already checked.
4. Click OK and measure 7 should have a special ending 1 notice.

Enter the notes in measure 7 of the upper staff.

Measure 8 in the upper staff has a slur. A slur means to play the connected notes
in a smooth manner, as if they really are connected. To enter the slurred notes:

1. Click the Half Duration  icon or press 2.

2. Click the Slur  icon or press the semicolon ( ; ).
3. Place the insertion point in the G position and press Enter.
4. If the Slur property is still enabled, turn it off now.
5. Place the insertion point in the C position and press Enter.

The two notes are now connected with a slur.

You have reached the end of the first pass. There needs to be some indication to
the player to go back to the beginning and play it again. This is done using a
repeat. To open the Bar Lines dialog box, do one of the following:

 Select Insert: Bar Line (Decorated).
 Right click mouse, select Notation: Bar Line (Decorated).
 Press the quick key B or b.

In the Bar Lines dialog box, select the Master Repeat Close and click OK. This
should place the repeat at the end of measure 8. The difference between the
Master Repeat Close and the Local Repeat Close is the Master Repeat Close is
used at an ending while the Local Repeat Close is used in the middle of a verse.
See the repeatx.nwc files in the Samples directory for more detail on repeats.
For each file, go to File: Info for an explanation..

At the start of measure 9, insert the second special ending, just as you did for the
first, except select 2nd Ending in the Repeat Loop Special Endings dialog box.

Finish entering the notes in the top staff for “Jingle Bells.”

Selecting an Instrument for Play Back
It is important to select an instrument for play back for your staves. Without
selecting an instrument, your song will use the instrument last played on that
channel of your sound card.
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To select an instrument for the upper staff:

1. Click the upper staff to make it active.
2. Press F2 to open the Staff Properties dialog box.
3. Click the Instrument tab.
4. Under Patch Name, select Bright Acoustic Piano. Click OK. The

instrument selections are a function of your sound card. If you do not have
this specific piano, select any piano or any other instrument.

You need to follow this same procedure to select an instrument for the lower
staff.

In “Jingle Bells,” you will use the same instrument for both staves. However,
when you work with songs with several instruments, each different instrument
needs to be assigned to a different channel on your sound card. As you add
staves to your song, NoteWorthy Composer automatically assigns each staff to a
new channel, as long as channels are available. If you add more staves than
available channels, you can assign staves with the same instrument to the same
channel. The channel is set with Staff: Staff Properties, MIDI, Channel.

You can view all the staves with their channel and patch assignment with the
Tools: Score Review command.

Configuring for Sound - Play Back
Even though you have not finished notating the song, you can play back what
you have created at any time. If you have not done so already, you need to
configure NoteWorthy Composer for sound. This means you need to tell
NoteWorthy Composer what device to use for play back. The directions for
configuring NoteWorthy Composer for sound can be found in the Help menu.
Select Getting Started and Configuring Sound in NoteWorthy Composer.

Once you are setup for sound, you can choose where you want NoteWorthy
Composer to begin play back. Go to the Tools menu and select Options. In the
dialog box, click the Midi tab. Here you can select Play to be from beginning,
from insertion point, from current measure or a few measures back. For now,
choose play from beginning. But remember you can come back and change this
later. Click OK.

Now you are ready to play back. To start play:

 Select the Tools menu option and Play.

 Click the Play Song  icon.
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 Press the quick key F5.

You should hear the upper staff of “Jingle Bells” play as the notes are
highlighted. If you do not hear play back, check the Help file for “faq: Problems
with play back.”

To stop play:

 Select the Tools menu option and Stop.

 Click the Stop Play  icon.
 Press the quick key F6.
 Press the ESC key.

Notate the Lower Staff
Just as you started the upper staff with the clef and signatures, the same must be
done for the lower staff. But this time, you can copy from what you have already
done in the upper staff and paste it in the lower staff. To copy and paste:

1. Select (highlight) the treble clef, the key signature and time
signature in the upper staff. (See Selecting on page 3 for how to
select.)

2. Click the Copy Selection  icon or press Ctrl+C.
3. Press Page Down to place the insertion point in the bottom staff.

4. Click the Paste Selection  icon or press Ctrl+V.

Congratulations! If you now have a treble clef, a key signature and a time
signature in both the upper and lower staves, you have successfully copied and
pasted. However, there is some tidying up to do.

First, the lower staff needs a bass clef instead of a treble clef. To change this,
select the treble clef in the lower staff (use the mouse or shift+arrow keys).
Now, press Alt+Enter. This is the Edit: Properties command and is used to
edit the properties of an item you have selected (highlighted). After pressing
Alt+Enter, the Clef dialog box will appear allowing you to a select bass clef.
Choose Bass Clef and click OK. There should now be a bass clef in the lower
staff.

Your key signature may not be properly aligned so press F9 (View: Refresh
Score) to refresh the score. This will update the staff to the new key signature.
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Chord Entry
In “Jingle Bells,” the lower staff, or left-hand part for piano play, contains all
chords (notes aligned vertically and played at the same time). Chords supply the
harmony for the melody being played on the upper staff, or right-hand part.

There is just one extra step to placing a note in a chord as opposed to spacing it
out by itself. To create a chord:

1. Enter the first note as usual.
2. Place the insertion point to the right of the first note

and at the correct pitch for the second note.
3. Press Ctrl+Enter to place the second note in the

chord.
4. Repeat steps 2 & 3 to add more notes to a chord.

Now that you know how to enter Chords, enter all the chords through measure 6.
If you make a mistake in a chord, you can easily remove a chord member. To
remove a chord member:

1. Place the insertion point to the right of the note you want to delete.
2. Press Ctrl+Backspace or select Edit: Remove Chord Note.

You can read more about the rules of chord entry in the Help File. Search on
Chord Member command.

Repeats in the Lower Staff
You also need to add the repeats in the bottom staff. Only the top repeat will
appear in the printed copy. However, NoteWorthy Composer needs the repeat in
all staves to know where to go while playing each staff.

You can select and copy (Ctrl+C) each special ending and the repeat bar in the
upper staff and paste (Ctrl+V) them in the lower staff. Or, use the appropriate
commands. Add the notes as necessary in these measures until you have
finished.

Play the Final Song
You have now completed your notation of “Jingle Bells.” If you have not saved
recently, do so now (File: Save, Ctrl+S or click the Save File  icon). Play
back of “Jingle Bells” will begin where you selected it to with the Options
command. If you did not choose to play from the beginning, scroll back to the

b i
ii  
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beginning or press the Home key. If you did select play from the beginning,
NoteWorthy Composer will scroll there automatically at the start of play. Start
play from the menu (Tools: Play), click the Play Song  icon or press F5.

You can also select one staff to play back at a time. To only play the top staff:

1. Click the upper staff to make it active.
2. Press Shift+F5.

You can also mute one or more staves for play back. To mute a staff:

1. Click the upper staff to make it active.
2. Click the Mute Staff        icon.

If you have several staves to mute, use Tools: Mute List (quick key M or m).

Lyrics
Even though you have finished the notation and your song sounds great, the
lyrics need to be added. NoteWorthy Composer can handle up to 8 lyric lines,
but this version of “Jingle Bells” will use only one lyric line. To enter lyrics:

1. Make the upper staff (the staff the lyrics will be attached to) the
active staff by clicking it.

2. Select Edit: Lyrics or press Ctrl+L.

3. On the Configuration tab, set the Line Count to be 1 Lyric Line.

4. Click the Lyric 1 tab. The other numbered tabs are for additional
lyric lines and will not be used for this song.

5. Type in the following text for lyrics, pressing Enter at the end of
each line:

Jin-gle bells, jin-gle bells, jin-gle all the way,
Oh, what fun it is to ride in a one-horse o-pen sleigh.
one-horse o-pen sleigh

6. Once the lyrics are entered, the OK button must be clicked for
NoteWorthy Composer to accept the lyrics. You cannot always
press Enter as with some dialog boxes, since Enter is used in editing
the lyrics. With the keyboard, you can also use the tab key to select
the OK button to avoid conflicts with the lyric text.
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Tips for entering lyrics:

 Each syllable of a word should be separated with a hyphen if you want
the syllables spread across notes.

 A space is used to separate words across notes.

 If you have notes that you do not want any lyrics assigned to, use the
underscore ( _ ) in the lyric editor for each note. You can also select the
notes that you do not want to have lyrics, press Alt+Enter, and under the
Notes tab, set Lyric Syllable to Never.

 For more advanced information on lyrics go to the Help menu and
search on "Lyrics Command."

Last Additions (Text Entry)
You may have noticed in the jingle.nwc file there is other text in the score
besides lyrics. This text will not alter the play back by NoteWorthy Composer,
but would be helpful to a piano or guitar player if you printed your notation of
“Jingle Bells” and asked them to play it. If you refer to page 5 or have the
jingle.nwc file open, you will see the word Lively. This sets the mood of the
piece for the piano player. You will also see an F being used as a chord symbol.

To enter the text “Lively:”

1. Place the insertion point between the clef and the key signature.
2. Select the Insert menu and Text or press the X key.
3. Type Lively in for Expression.
4. Set the Display Font to Staff Bold.
5. Under Expression Placement, set Staff Position to 13 and do not

Preserve Width.
6. Click OK.

You should see Lively at the top of the score with a little diamond beside it.
Since you did not Preserve Width, the diamond appears so you will have
something to select when you need to edit (Alt+Enter) the text. The diamond
will not show in your printed copy. (See page 39 for more on Preserve Width.)

a
LLively

f 44
LF
kz kz k n



Notating Jingle Bells 19

Follow the same process to enter the chord symbols in the song. The Staff
Position for the chord symbols is 8.

Printing “Jingle Bells”
Now that your notation is complete, you may want to print it. To print, you first
need to make sure that the correct printer is selected. This is done with File:
Printer Setup. Set Name to be the printer you want to use for printing. You can
also check the paper size and orientation here.

Once you have the correct printer, you can focus on what you want to print and
how you want it to look. The following selections are under File: Page Setup.

• Contents tab - Check the staves that you want to print.
• Options tab - Set details of your song; such as, notation size, measure

numbers, whether to print the title and/or staff labels. If you have
questions about the settings, click the Help button.

• Margins tab - Set the margins measured from the edge of the paper.
• Fonts tab - Set the font size and style for lyrics and other text. Use the

defaults for now. For more information on Fonts, see page 24.
• Preview tab - Preview your song before printing. If you do not like the

format, go back to the Margins tab and Options tab and make changes
accordingly.

Once you like what you see in Print Preview and you are ready to print, do one
of the following:

 Select the File menu option and Print.

 Click the Print  icon.
 Press Ctrl+P.

If you will use the same print settings for most of your songs, you may want to
create a Print template. You can also edit the existing templates with your print
margins and other settings. For more information on Templates, see page 28.

Congratulations!
You have completed the entire song: notes, lyrics and all. Your final notation
should look just like the file jingle.nwc. Hopefully, you now have a good idea
how NoteWorthy Composer works.
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How To…….
This section provides steps for several common and advanced tasks you are able
to perform using NoteWorthy Composer.

Get drum sounds to play back
Usually on sound cards, the percussion sounds are assigned to channel 10 or
channel 16. You will need to try both channels to see which one works for you.

1. For an existing staff of notes, press F2 to access Staff Properties.
2. Under the Midi tab, set the channel for 10 or 16 and click OK.

3. Click the Play Song  icon or press F5.
4. If you hear percussion sounds, you have found your percussion channel.

If you do not, go back to Staff Properties (F2) and change to the other
channel (10 or 16) and verify it is your percussion channel.

5. Now that you know your percussion channel, you need to know how to
make different sounds. The percussion sound is determined by where
notes are placed on the staff. For example, a C note is a bass drum,
while a D note is a snare drum. See page 49 of the Appendix for a list of
percussion sounds (General MIDI Drum List) and more explanation.
Also, see the sample song file drumref.nwc.

Cut and paste lyrics
When working with lyrics you may want to copy, cut and paste lyrics within the
Staff Lyrics dialog box or between NoteWorthy Composer and another
application. You can copy, cut and paste lyrics by using the Windows clipboard
manipulation keys (instead of the Cut, Copy or Paste in the NoteWorthy
Composer Edit menu).

1. While in the lyric editor (Ctrl+L), select (highlight) the section of lyrics
you want to work with by holding down the left mouse button and
dragging it across the lyrics or by using Ctrl+Shift+←→.

2. Press Ctrl+C to copy the lyrics or press Ctrl+X to cut the lyrics.
3. Place your insertion point where you want to insert the copied or cut

lyrics.
4. Paste the lyrics by pressing Ctrl+V.
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Change instrument in staff for play back
During play back, to hear different instruments play certain sections of a staff,
you can use an instrument patch.

1. If you will only have one instrument playing the entire staff, or to set up
the first instrument to be played in the staff, select Staff: Staff
Properties or press F2.

2. Click the Instrument tab. Under Patch Name select the instrument you
want for play back and click OK.

3. After entering your notes, place the insertion point in the staff where
you want the first instrument to stop playing and a different instrument
to start.

4. Select Insert: Instrument Patch or press the quick key I. On the
Instrument tab, under Patch Name, select the instrument you want to
start playing at this point instead of the previously selected instrument.
Click OK.

5. The symbol {patch #} will appear to mark where the instrument change
takes place. (The symbol will not appear on your printed copies.)

6. You may add additional patches by following the same process.

Change or add the key signature
1. Force Accidentals (Tools menu) to assign an accidental to each note.
2. If a key signature exists, select it and press Alt+Enter to change it. If

there is no key signature, press K and enter a key signature.
3. Audit Accidentals (Tools menu) to update notes to the key.
4. If necessary to change the enharmonic spelling of notes, use Tools:

Audit Enharmonic Spelling. (A# is the enharmonic spelling of Bb, the
notes are the same pitch but written a different way.)

Change notes to a new clef
1. Select the clef and press Alt+Enter to change the clef.
2. Select the notes to be changed and move them using Ctrl+Shift+↑↓.
3. Press F9 (View: Refresh Score) to update the key signature.
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Transpose
Transposing a staff is the process of notating the staff in a different key than the
key for which it was first written. If you are playing piano from a printed score
and a friend with a B Flat trumpet joins you in playing direct from the score, it
will sound horrible. This is because when the trumpet plays a C, it will sound
like a B flat. Since you used NoteWorthy Composer for your score, you can
quickly transpose the piano score for the trumpet player and provide a print out.
The trumpet player will need a piece transposed up 2 semitones from the piano
piece, since it is two steps up from B flat to C. To transpose a staff:

1. Select Tools: Transpose Staff.
2. Select the number of semitones (up or down) by which you would like

to transpose the staff. The range is -12 to 12. An octave is broken into
12 semitones, or steps. Click OK. The notes should move on the staff by
the number of semitones indicated.

For proper sounding play back after the transposition, leave Update staff play
back transposition checked. This will automatically update the MIDI play back
transposition by the opposite number of semitones just visually transposed. The
play back transposition selection can be altered manually in Staff Properties (F2)
under the MIDI tab. This is necessary because sound cards do not play the way
instruments really do, but play instrument sounds at the given concert pitch. An
actual B flat trumpet playing a note in the C position would sound like a B flat.
Whereas, with the Instrument set for Trumpet, sound cards will play a note in
the C position at C pitch with a trumpet sound.

If the staff to transpose is in the key of C and the key is not shown on the staff,
you need to use Insert: Key Signature to insert the key and then transpose.

You may also want to Audit Note Stems (Tools menu) after a transpose to reset
notes stems to logical directions.
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Use repeats, flow direction and special endings
There are several different ways to alter the direction of play. One way is to use
repeats to play a section again. If you have a few measures of a song you want
repeated, use the Master Repeat Open and Master Repeat Close under Insert:
Bar Line (Decorated). For example, if you enter the following piece in
NoteWorthy Composer and play it back you will hear and see the highlighted
notes repeat between the Master Repeat Open and Master Repeat Close.
Never pair a Master Repeat with a Local Repeat.

repeat section

To repeat a section several times, use Local Repeat Open and Local Repeat
Close under Bar Line (Decorated). When you select Local Repeat Close, you
will be prompted to enter the Repeat Count. An example of a local repeat with a
repeat count of three is below. The middle two measures will be played back
three times before continuing to the last measure. Never use a special ending
with a local repeat. It will not work.

 repeat section 3 times

Another way to use the repeat signs is with special endings. Special Endings are
found in the Insert menu. In the sample below, the third measure is the ending
for the first pass (the 1st Special Ending) and the Master Repeat Close directs
play back to the start. On the second pass, the first special ending is skipped and
play goes to the 2nd Special Ending. The sample song jingle.nwc uses special
endings.

In addition to repeats and special endings, flow direction symbols also alter the
direction of play and are found in the Insert menu, under Flow Direction. To
understand the different selections, it is important to know two terms. First, Da
Capo means from the beginning and is often abbreviated D.C. The second is Dal
Segno (D.S.) and means from the sign. In addition to the following example, the
sample song file rose.nwc also uses flow directions. It may be helpful to play the
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file and follow the play direction.

In the above example, the song will play through to the D.S. al Fine. After the
D.S. al Fine instruction, the song will go back and play from the sign to the
Fine.

There are several song files in the Samples folder that demonstrate the use of
flow direction signs and repeats. The song files are named repeatx.nwc where x
is a number. When you open the examples, go to the File Info dialog box
(Ctrl+I) for an explanation of what the file demonstrates.

An additional tip when working on the flow of a song is to break the song into
blocks. These blocks are individual sections that may or may not be played more
than once, but they can be separated. Then give each block a name, like A, B, C,
etc. Then write out the flow of the song, using the block names. For example,
your song may flow ABACDAC. From that, figure out how to implement
Repeats, Flow Directions and Special Endings in your song. This will help you
see at a higher level without all the measures of notes clouding your view.

Change lyric size and font
In some cases you may want to keep the staff size the same, but increase the size
of the lyrics. You may also want to use a font other than the default Times New
Roman. Following are the steps to change the lyric size and font for an open file:

1. Select File: Page Setup.

2. Click the Fonts tab.

3. In the scroll box, click Staff Lyric and click Modify.

4. In the Font dialog box, change the Font, Font style and Size as you like.

5. Click OK.

As you can see from the dialog box, the font can also be changed for the title
information, text expressions, and more. Click the Help button in the Font dialog
box for more information.

a 44
 j j

x
j j j j j j  

Fine

a j j j j j j j j D.S.x  al Fine



How To……. 25

If you have a music font package or guitar tablature font package, you can select
them as a User font and insert the symbols with Insert: Text.

Remember: If you use fonts that others do not have, your song will not display
correctly on their machine.

Increase/decrease volume during playback
Using Dynamics and Dynamic Variances together in NoteWorthy Composer
will allow you to increase or decrease volume over a section during play back.
The Dynamic Variance Crescendo (cresc) is an instruction to gradually
increase volume, while Decrescendo (decresc) instructs to gradually decrease
volume. The Dynamics range from the very, very soft Pianissimo (ppp), to the
very, very loud Fortissimo (fff). As an example, follow the instructions to create
the staff below that will increase in volume from the p to the ff:

1. Enter the clef, time signature, notes and bar lines as above.
2. With the insertion point to the right of the first bar line, select Insert:

Dynamic or press the quick key D.
3. On the Dynamic tab, select Style: Piano.
4. Check the box for Override Default Note Velocity and set the value for

127. Note velocity is how hard a note is struck.
5. Check the box for Override Default MIDI Volume and set the value for

30. Here, you are setting the volume (range of 1 to 127), instead of using
the default.

6. Click OK to exit the dialog box and you should see the p on the staff
with the settings you selected- p(127,30). The settings will not show in
printed copies, only the p, as in the example staff.

7. With the insertion point to the right of the second bar line, select Insert:
Dynamic Variance or press the quick key Y.

8. On the Dynamic Variance tab, select Style: Crescendo.
9. Click OK to exit the dialog box and you should see cresc on the staff.
10. With the insertion point to the right of the third bar line, select Insert:

Dynamic or press the quick key D.
11. On the Dynamic tab, select Style: Fortissimo.
12. Check Override Default Note Velocity and set the value for 127.
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13. Check Override Default MIDI Volume and set the value for 127.
14. Click OK to exit the dialog box and you should see the ff on the staff

with the settings you selected- ff(127,127). The settings will not show in
printed copies, only the ff, as in the example staff.

15. Click the Play Song  icon or press F5 to hear the result.

Combine tracks of a MIDI file
When using File: Open in NoteWorthy Composer to import a *.mid file, the
number of staves created is based on the number of tracks in the *.mid file.
There may be a case when you would like to reduce this to one track so you will
have one staff in your NoteWorthy Composer song file. Here is a method you
can use that will bring you very close to that goal.

1. Import the *.mid file with File: Open.

2. Use File: Save and set Save as type: Type 0 MIDI File to export the
file as a Type 0. File Type 0 puts everything on one track, while File
Type 1 keeps separate tracks.

3. Import the file. Do not check "Map each MIDI channel to a new staff”
and set “Max single track chord size" very high, like 100.

4. All information should now be on one staff.

You may lose some information importing, exporting and importing again, but it
may be worth it to you.

Hide symbols, notes, bar lines, etc
Most symbols, notes, bar lines, etc. can be hidden for printing. To hide an item:

1. Select the item.

2. Press Alt+Enter to open the Properties Dialog Box.

3. Click the Visibility tab.

4. Set “Show on printed page” to Never.

Once you know how to hide items, you can do print things like: blank sheet
music, music that does not have bar lines, a blank staff line below a staff of
music, lyrics that do not look like they are assigned to notes.
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Record play from a MIDI keyboard
If you have a MIDI keyboard or other MIDI input device connected to your
computer, you can record and notate from your keyboard.

1. Go to Tools: Options and click the Record tab.
2. If not already set up, select the Input Device for your system. This will

not need to be set every time.
3. Still under the Record tab, under Import Options, select the placement

of the notated recording when completed. The choices: New Window,
Record Group (of score playing while recording) or Buffer Only.

4. Click OK.
5. Press Ctrl+N, Rhythm tab and select a score that you will use for

background play as you record. A score must be open and playing to
record. NoteWorthy Composer provides several Rhythm templates that
are helpful in recording or you can use your own song file.

6. Click the Record        icon or press F4.
7. Play your MIDI keyboard (or MIDI other device) along with the rhythm

or song.
8. Press F6 to stop recording or recording will automatically stop at the

end of the background song.

Under Import Options, if you selected:

New Window - The recording will appear in a new window.
Record Group - The recording will show in the background song’s window.
The recording will be in its own group entitled Record.
Buffer Only - Access the notated recording with Staff: Import Recording.

Remotely input notes from a MIDI keyboard
If you have a MIDI keyboard or other MIDI input device, you can input notes in
step time. This means you can enter the note pitch from the MIDI keyboard. The
duration is not recorded, just the pitch. Since this is not a live recording, notes
and chords can be entered at your own pace. To enter notes in step time:

1. Go to Tools: Options and click the Record tab.
2. If not already set up, select the Input Device for you system. This will

not need to be set every time unless you change devices often.
3. On the Midi tab, set MIDI port usage to While Active or Always. This

will not need to be set every time.
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4. Select Tools: MIDI Input Active or click the MIDI Input Active
 icon.

Now when you press a key (or keys for a chord) the note(s) will be entered in
the score on the active staff. Durations for the notes can be selected using the
computer keyboard quick keys, the mouse to click the note duration icons or
possibly from controllers on your MIDI keyboard. Search the Help file for
“MIDI Input Active” for more information on MIDI keyboard controllers that
can be used to set note duration.

Create Templates
When you open a new song file in NoteWorthy Composer, you are presented
with the Song Templates dialog box. Some templates are provided for you, such
as the Piano template that opens with two staves connected with the piano brace.
Once you open a template, you can edit it and save it without altering the
original template. Several methods for creating your own templates are listed
below.

Change the provided templates and save them as new templates

1. Open the template that you want to change.
2. Change the features as you wish (it may be as simple as you want the

tempo slower and you select the diamond beside the tempo and press
Ctrl+ E to edit it).

3. Select File: Save As.
4. Save file under the Template folder as a name you choose.
5. Now when you enter Ctrl+N, your template will be in the Templates

dialog box.

Create a template from the beginning
1. Create your song file.
2. Select File: Save As.
3. Save file under the Template folder as a name you choose.
4. Now when you enter Ctrl+N, you template will be the Templates dialog

box.

Dragging and Dropping files to templates
1. Press Ctrl+N to access the Song Templates dialog box and click the tab

heading that you want your template to be placed under.
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2. Locate the file template you created, or a song file that you want to be a
template, on an Explorer window or the File Manager.

3. Drag and drop the file you created onto the Song Templates dialog box.
To drag and drop -- In the Explorer window or File Manager, left click
the file you created and continue to hold down the left mouse button.
Then, drag the file over the top of the Song Templates box and release
the left mouse button.

You can also create your own tabs in the Song Templates dialog box. Search the
Help file for “New Command” for more information.

Enter a Fermata
The fermata symbol over a note indicates to hold the note longer than its written
duration. The fastest way to enter a fermata is to click on the icon on the Insert
tool bar. The following steps illustrate how to place a fermata over a note with
the Insert menu.

1. Place the insertion point to the left of the note that you want to fermata.
2. Select Insert: Tempo Variance or press E.
3. On the Tempo Variance tab, select Fermata for style
4. If you do not like the position of the fermata, select (highlight) the

diamond beside the fermata and press Alt+Enter to edit the staff
position under the Expression Placement tab.

Get right & left hand staves from MIDI recording
Here are some settings to get two staves from right hand and left hand MIDI
keyboard recording:

Tools: Options, Import, Maximum Single track chord size: Decrease this
number, 12 may be a good starting point. Record, see how the new number
works, change number and try again, until you get better results.

Staff: Import Recording: Once you record a MIDI performance, you can
import with this command as many times as you want. You can import the first
time and set the note range to be for the right hand. This will set a staff for the
right hand. Import a second time and set the note range to be for the left hand
part. This will set the staff for the left hand under the first staff.

a 44 k k k
y
k

 



30 How To…….

Move your song file to another application
If you are writing a paper on music or putting together a music test, you may
want to insert parts of staves or songs from NoteWorthy Composer into another
application. For example, the staff sections in the “How To” section of the
user’s guide and the printed song “Jingle Bells” were first created in NoteWorthy
Composer and then inserted into a word processor. This was accomplished by
creating a Windows metafile from NoteWorthy Composer. The staff sections in
the “Notating Jingle Bells” section of the user’s guide were created with Edit:
Copy Special. See next topic for using Copy Special.

1. Create and save the staff or song that you want to move to another
application.

2. With the file open, select File: Print Preview.
3. Click the Copy button.
4. Select a file format or clipboard.
5. Next, paste (Ctrl+V) to your other application. The Print Preview Copy

feature copies pages at half of their actual printed size. You can make
the copied page match the actual printed page by simply doubling its
size in the other application.

Tips for variables to change in Page Setup and Print for better performance:

 Printer: The higher the printer resolution, the larger the file, which
requires more RAM for using the file. For example, if the printer is set
for your laser printer and the bitmap cannot be created, select your fax
software.

 Staff size: If you will be placing the staff in a smaller area, selecting a
smaller font size in NoteWorthy Composer should give better results.

 Margins: If you only want the staff to take up 4 inches in width by two
inches in height in the other application, go ahead and set those margins
in NoteWorthy Composer.

Copy staff for use in another application
The staff sections in the “Notating Jingle Bells” section of the user’s guide were
created with Edit: Copy Special. This command copies the selected staff area
and places it in the Windows clipboard.

1. Select (highlight) the section of the staff you want to copy.
2. Select Edit: Copy Special.
3. If you only have one staff, the section has been copied to the Windows
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clipboard. If you have more than one staff, you will be asked if you want
to copy only the active staff or copy all staves.

4. Go to your other application and press Ctrl+V to paste the staff/staves.
Tips for different looks when using Copy Special:

 In File: Page Setup, toggle Increase note spacing for larger note
durations for more or less space between notes.

 Use Insert: Text to insert spaces around areas you will copy. For
example, if you want to copy the clef on the staff but not the starting bar
line, insert spaces after the bar line. Then select only the clef to be
copied.

 If your printer or application will not print some of the staff once you
have pasted it to the application, try making the active staff color black
(Tools: Options, Editor tab).

Increase space around a staff
On occasion, you may have notes that go off the top of the staff or move into the
staff below. There is any easy way to add more space around your staves.

1. Press F2 to open the Staff Properties dialog box for the staff.
2. Under the Visual tab, increase the numbers under Vertical Size, Upper

and/or Lower. Increasing the Upper number will provide more space
above the staff and increasing the Lower number will provide more
space below the staff.

Move through the tabs without the mouse
When you go to a command such as File: Page Setup or Tools: Options that
includes several tabs, you may want to use the keyboard to move through the
tabs instead of using the mouse. To do this, use Ctrl+Tab to move from tab to
tab. The arrow key will move to the items within the tab.

Start play from a point other than the beginning
1. Select Tools: Options.
2. Click the Midi tab.
3. Under Play Options select Play to start from beginning, from insertion

point, from the current measure, or from 1, 2, or 3 measures back.
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Fade volume with the Multi-Point Controller
The Multi-Point Controller (Insert menu) allows sophisticated control over
the play of a song. For example, it can be used to fade the volume, speed up a
section or implement a pitch bend.

The following example demonstrates how it can be used to fade out the volume.
In NoteWorthy Composer, create a staff with notes like the one below.

Place the insertion point after the first bar line and select Insert: Multi-Point
Controller. Use the same settings as in the dialog box below.

Controller - Volume: indicates this controller will affect volume
Style - Linear Sweep: the change will be gradual; not all at once
Time Offset Multiplier - Quarter: Multiply by Time Offset for duration
Linear Sweep Contour - 1: the size steps the sweep will take during the control
The remaining settings indicate the first note will be at a volume of 127 and over
a time period of 8 Quarter notes (Time Offset x Multiplier), the volume will
decrease to 29. Click OK.
Play the staff and you will hear the volume fade.
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Put two voices on one staff for SATB
Staff layering will allow you to notate each voice on a separate staff and then
merge the staves for printing and viewing. The sample song file layering.nwc
demonstrates this feature.

1. File: Open layering.nwc. It is located in the Samples folder.

2. In File: Page Setup, Contents, Allow Layering, click so there is no check
mark for Allow Layering. Click OK. Now you can see how each voice is on
a separate staff. Here you can edit each staff.

3. Click the top staff to make it active.

4. Press F2 (Staff Properties) and select the Visual tab. For the top staff, you
will see that “Layering with next staff” is checked. Press OK. Press Page
Down to make the next staff active. Press F2. Here you will see that it is not
layered because the top staff will layer with it. Continue this process to see
the third staff is layered with next and the fourth staff is not layered.

5. In File: Page Setup, Contents, Allow Layering, click so there is a check
mark for Allow Layering. Press OK. Now the staves are layered again. You
can still use Page Up and Page Down to cycle through the staves and you
can use Shift+F5 to play only one voice.

With Staff Layering, you may find that rests and notes overlap. If this is the
case, change the position of the item by selecting the note or rest and pressing
Alt+Enter. Under the Notes tab, you will be able to adjust the spacing of the
note and the vertical offset of the rest.

You may also find that you need to change the direction of a slur or tie. To do
so, select the tied or slurred notes, press Alt+Enter, and set the direction to
Upward or Downward.

Use groups
Groups allow you to break the score into sections. For example, if you have a
repetitive drum beat in your score that has one measure repeated many times,
you may not want it to show during editing and play. In this case, the drum staff
could be a different group than your melody. If you want to practice with
NoteWorthy Composer while looking only at your vocals or your instrument, put
the other parts in a group so you can hear them, but not see them.

1. Make the staff you want to put in a separate group active by clicking it
or using the Page Up/Page Down keys to reach it.

2. Select Staff: Staff Properties (F2). Click the General tab. For Group,
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enter the name of the group under which this staff will be sectioned. For
example, if you have a rhythm staff, you could name the group
“Rhythm.” (You may have many staves in one group or many groups
with one stave each, but a staff can only be in one group.)

3. Use File: Page Setup, Contents to select which group(s) will be shown
in the work space.

There are two song files in the Samples directory in which groups are used.
Nowell.nwc was created with two groups to use as a test for sound cards. The
notation in each group is the same. However, in the play channels are different.
This allows a user to see the song in a logical fashion and provides test results in
determining if a sound card’s play back is channel specific.
Moonlite.nwc also has two groups, one for play back and one for display/print.
The reason for this is visual ornaments were created with Insert: Text for the
display group (named Standard) and then the ornaments were notated in the play
back group (named Hidden). The play back (Hidden) group would not be shown
on in the workspace or printed. The display (Standard) group would be muted to
hear the play back group. See measures 30 and 59 for examples.
An easy way to get an overview of these files is Tools: Score Review. This
dialog box lists the staves and the groups. To see all the groups in the work
space, use File: Page Setup, Contents tab.

Customize the toolbars
The toolbars in NoteWorthy Composer can be customized to show only the icons
you want in the number of toolbars you want. You can edit the existing toolbars
or create your own.

As an example of editing toolbars, follow this example to add the double dotted
duration icon to the Notes toolbar after the dotted duration icon.

1. Select View: Toolbars.

2. Click Customize.

3. Under Toolbar in the top left, select Notes.

4. Under Available Tools, scroll until you find Note Double Dotted and
double click it to put it in the Active Tools Window.

5. Find Note Double Dotted in the Active Tools Window and double click
it.

6. Press Up or Down button to move it under Note Dotted in the List

7. Click Close.
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This example shows how to delete icons from the notes toolbar.

1. Select View: Toolbars and click Customize.

2. Under Toolbar in the top left, select Notes.

3. In the Active Tools window, double click any icons you want to
remove.

4. Click Close.

To create your own toolbar:

1. Select View: Toolbars and click Customize.

2. Click New.

3. The title Custom will appear for Toolbar. You may want to insert your
name or a description of the new toolbar over Custom.

4. Under Available Tools, double click the icons you want in your toolbar.

5. Click Close.

To select the toolbars that will show on your screen, select View: Toolbars and
check the toolbars you want to show.

Enter music symbols not listed
NoteWorthy Composer allows for the use of different fonts with File: Page
Setup, Fonts. The command Insert: Text allows for the placement of items on
or around the staff. Using these tools, you can insert items such as graphical
crescendos, bow markings, rehearsal marks and the like.

You can use music fonts that you have purchased or that you have created. If
you go to the NoteWorthy Composer User Tips web page located at
http://noteworthycomposer.com/usertips.htm you will find several music symbol
fonts created by fellow NWC users.

Select the ending bar line style
1. Click the staff to make it active.
2. Press F2 for Staff Properties.
3. Under the General tab, make the selection under Ending Bar.
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Troubleshoot with Score Review
The Score Review command under the Tools menu is not only a summary of the
song’s staves, but also helpful in troubleshooting sound problems. Following is
a list of the fields in Score Review and how they can help:

Name and Partition: In general, this will show how many staves are in a song,
even if some are layered or hidden. This may help with other people’s files, if
they refer to staves by name instead of position, you can quickly see where the
staff is located. It could also help you to keep your staves in order if you are
working on an Orchestral Piece. These items are both set on the General tab of
Staff Properties.

Mute: This field provides a quick check to see if you have muted a staff and did
not intend to leave it muted. Y = muted and N = not muted. This can be set on
the MIDI tab of Staff Properties, Tools: Mute List or the Mute Staff icon.

Port: The port number correlates to the Play back device setting on the MIDI
tab of Staff Properties. The first selection is Port 1, the second selection is Port
2, and so on. These then correlate to the Devices used by play back set in Tools:
Options, MIDI. How this would help in trouble shooting is, if you received a file
and a staff was not sounding (and it was not muted), it may be that they had that
staff assigned to a Port that you do not have a play back device assigned to.

Channel: MIDI devices can support up to 16 channels. Each channel can only
handle one instrument patch at a time. If you wonder why the violin is sounding
like a flute instead, it may be that you have both staves assigned to the same
channel. You need to change the channel for one staff. Or, if your trumpet staff
is making percussion sounds, you can check and find that it is assigned to the
percussion channel (10 or 16). Similarly, volume and other performance
parameters can only be controlled by one channel. So even if you have 2 piano
staves assigned to the same channel, which would normally be OK, if you want
a different volume for one staff, they will need to be on different channel.
Channel is set with Staff: Staff Properties, MIDI, Channel.

Patch: Knowing the patch can help you review what instruments you have
assigned; as well as, verify proper channel alignment (as discussed above).

Trans: If you have a staff that is sounding at a different pitch than it is notated,
the Transposition field can help. Transposition is controlled by the "Update staff
play back transposition" checkbox in the Transpose dialog. When checked, the
results after the transpose will sound at the same pitch, even though you
transposed. If you did not mean to leave this checked, you can reverse the effect
by going into Staff Properties (F2), the Midi Tab, and changing the
Transposition field to "+0" (example), rather than the "+3" (example) that it was
changed to after the Tools: Transpose command was used.
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From Score Review, if you need to edit any of the fields, click the Goto Staff
Properties… and you will be taken to the Staff Properties Dialog box. After
making the changes and clicking OK, you will be brought back to the Score
Review dialog box.

Work with different file types
NoteWorthy Composer will open NoteWorthy Composer song files (*.nwc) and
will import Standard MIDI files (*.mid) with File: Open.

When you select File: Open, the file types displayed in the box will depend on
the selection in "Files of type:" If you have NWC Files selected, only songs with
the *.nwc file extension will be shown. If you have Midi Files selected, only
songs with the *.mid file extension will be shown. Lastly, if you have Song files
selected, both types will be shown. Keep this setting in mind if you want to open
a file and cannot see it in the list - you may just need to show that file type.

If you select a *.nwc file, it is opened right away as this is NoteWorthy
Composer's native file format. However, if you select a *.mid file, the MIDI
Import Wizard will be started. This is because NoteWorthy Composer will need
to convert a MIDI "performance" saved as a Standard MIDI file into visual
notation used by NoteWorthy Composer.

The same idea from above applies when using File: Save As. When you select
File: Save As, the file type the song will be saved as depends on the selection in
“Save as type:” If you have Standard NWC File selected, your file will be saved
in NoteWorthy Composer file format with the *.nwc extension. If Type 1 MIDI
File or Type 0 MIDI File is selected, your file will be exported as a *.mid file.
When exporting as a *.mid file, NoteWorthy Composer “plays” your notated
score performance into a MIDI file. File Type 0 puts all the information on 1
track. File Type 1 can use many simultaneous tracks or only 1 track. With that
said, you may have this question:

What is MIDI?

MIDI stands for Musical Instrument Digital Interface. It can be used to refer to
the protocol, the interface and the file format. It was developed as a standard so
musical instruments could talk to each other and so musical instruments could
talk to computers.

The protocol sends messages such as note on, note off and note velocity.
Because it is a list of instructions on how to generate sounds, a MIDI file is
different from an audio file that actually includes the sounds. Thus, a MIDI file
is much smaller than an audio file. A MIDI file is not based on visual notation,
but on commands to turn notes on and off.



38 How To…….

Access more properties for an item
There is more that can be done to a note or group of notes than just assigning a
duration, an accidental, a slur or the like. When you select a note (or group of
notes) and press Alt+Enter, a dialog box appears to give you more control over
the note. If you are not familiar with how to select notes, see Selecting on page
3. This Notation Properties dialog box allows you to change the spacing, mute
the note(s), turn off ledger lines, change tie and slur direction, change the color,
mark it to never be printed and more. For most any item entered (rests, bar lines,
tempo variance, etc), you can select it and use Alt+Enter to access the properties
dialog box for that item to have more control.

Change the number of lines in a staff
When you add a new staff (Staff: New Staff), the default number of lines in the
staff is 5. However, if you would like to change that default:

1. For the active staff, go to Staff: Staff Properties (or press F2).

2. Under the Visual tab, in the Lines field, set the number for the staff.

Find a specific entry in a large score
Go to Edit: Find (quick key Ctrl+F) to set what you would like to find on a
staff. In the dialog box, you are able to search on an Expression or a Category of
entries such as Dynamics, Flow Direction, etc. Once you have found the first
item, you can continue through the staff finding more of those items by pressing
F3 (Edit: Find Next).

Share your *.nwc song files
There are several supporting freeware products that will allow you to share your
song files  (*.nwc) with your friends, family and fans. These are on the CD as
well as available for download from NoteWorthySoftware.com. The
NoteWorthy Composer Browser Plug-in extends the capabilities of your web
browser to include the display, play back and printing of *.nwc song files. As an
NWC user and web page designer, show your *.nwc song files in action on your
site by embedding the song files to display in the NWC Browser Plug-in.
NoteWorthy Player is an application that will display and play back *.nwc song
files. With the NoteWorthy Composer Winamp Plug-in, *.nwc song files can be
added to a Winamp play list.
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Common Questions
You will find more questions like the ones below in the Help file by searching
on “Answers to Common Questions.”

What does ‘Preserve Width’ mean?
You will see the option to Preserve Width in dialog boxes under Expression
Placement. One example is Insert: Text. If you select Preserve Width, the text
will take up its own width on the staff and notes will start after the text. If you
do not select Preserve Width, the text will not take any width on the staff. In this
case, text placed at the top of the staff will allow notes to be entered under the
text. If you do not Preserve Width, the symbol or text you are entering will
appear with a diamond beside it. Since the item has no width of its own, the
diamond gives you something to select for editing or deleting. The diamond will
not appear in your prints.

When do I use Force and Audit Accidentals?
Force Accidentals will force an accidental sign on each note. You may want to
force accidentals before changing the key signature. Audit Accidentals will
update a staff after a key signature change to make sure notes do not have
accidentals marked if the accidental is part of the key.

Is there a way to quickly edit symbols?
There is an easy way to edit symbols like the clef, key signature and text. First,
select (highlight) the item, then press Alt+Enter. The dialog box for that item
will appear for quick editing.

Why are my Beam and Triplet commands not available?
You must select a proper sequence of notes for the commands to become active.
For example to beam notes, you must have at least two flagged (ex: eighth)
notes selected (highlighted). Once selected, the beam icon will become available
as well as the ability to use the quick key Ctrl+B. Clicking the beam icon or
pressing Ctrl+B will beam the selected notes.

Is there a way to keep an icon active?
Yes. For example, if you will be entering more notes that are accented (Notes,
Accent) than are not accented, use Persistent Note Tools (Tools menu) to keep
the Accent icon active. To do this, click the Accent icon and then click the
Persistent Note Tools icon.
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How do I know what version I have installed?
Use the About command in the Help menu.

How can I quickly move around in the song?
If you are using measure numbers, Ctrl+G allows you to input a measure
number to Go To. You can also use standard word processing keys such as
Home, to go to the beginning and End, to go to the end. These quick keys and
others are listed in the Help file. Search on Keyboard Guide.

Is there a way to only print certain staves of a song?
In File: Page Setup, Contents tab you may check the staves and/or groups you
want to print.

Where do I input the song title for printed copies?
The title of a song is input when you first start the song in the File Info dialog
box. If you need to add or change the song title, the command is File: Info
(Ctrl+I) or click the Authoring Info icon.

How do I label staves as flute, trumpet, etc?
Staff labels are created with Staff Properties (F2). Under the General tab, under
Name, enter the label. In File: Page Setup, Options tab, you have the choice of
which staves to print the staff labels with, if at all.

Can you move a note without deleting and re-entering it?
For any selected notes, the Ctrl+Shift+↑↓ keys will move the note(s) up and
down on the staff.

How do I select how I want the staves to be connected?
To connect your staves in an orchestral fashion or with a brace (as for piano), go
to Staff Properties (F2) for each staff. Under the Visual tab, under Style, select
Orchestral or Upper Grand Staff and Lower Grand Staff (for the brace).

Where can I view a summary of the staves?
Select Tools: Score Review (quick key R) to see a list of staves. Information
about the staves includes whether it is muted, port and channel assignment,
patch and transposition.

How can notes be placed closer together on the staff?
The command File: Page Setup, Options tab allows you to toggle the setting
Increase note spacing for larger note durations.
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How do I convert MIDI files to notation?
To open Standard MIDI Files (SMF), use File: Open. Make sure under Files of
Type, that you have MIDI Files or Song Files selected so you will be able to see
songs with the *.mid extension. The import wizard will step through the import
process. Defaults used for importing can be set in Tools: Options, Import.

How do I select different staves to play back?
If you only want one staff to play back, make the staff active and press Shift+F5
for active staff play. If you want some staves to play and some not to play, use
Tools: Mute List for quick access to setting staves to mute or not mute.

How do I create a MIDI file (*.mid)?
To export your NoteWorthy Composer song file (*.nwc) as a Standard MIDI File
(SMF) use File: File As and under Save as Type, select Type 1 or Type 0 MIDI
File.

How can I enter a note with an up and down stem?
Enter this just like a chord. Enter the first note with the up stem icon active, then
make the down stem icon active and press Ctrl+Enter.

Can I create my own toolbars?
Yes, you can modify the existing File and Note toolbars and create new toolbars.
This is done in View: Toolbars, Customize.

What is different between a Type 1 MIDI file and Type 0?
File Type 0 puts all the information in a single track. File Type 1 maps each
staff to a separate track in the MIDI file.

How do I get page numbers on my print?
Page numbers are set in File: Page Setup, Options tab. Page numbers are placed
in the upper right corner of the page. If you have Page Numbering checked and
you do not see the numbers on your print, you need to increase your margins.

How do I select what staves to show in the work space?
The staves shown in the work space are the staves that will be printed when you
use the Print command. Thus, to select the staves to show in the work space, use
File: Page Setup, Contents tab.

Is there a way to rearrange the order of the staves?
Use Staff: Move Staff or Ctrl+Shift+Page Up/Down.
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Where do grace notes get their time?
When grace notes are used in a song, they do not take visual space for time, nor
do they take time away from the count for the measure. That is, the regular notes
will line up in time and be counted for the beats in the measure. However, in
play back, grace notes steal time from the note following the grace note(s).

What is the difference between a tie and a slur?
A tie is used to connect 2 notes of the same pitch. The first note is played and
held for the duration of both notes. A slur connects any number of notes of any
pitch and all the notes are played in a smooth, connected manner.

Will it destroy a song template to save it as my song?
When you use File: New and select a template, this is now your song file. You
can notate in this file and save it (File: Save or Save As) as your song file. This
will not remove or over-write the template. The template will remain
unchanged. You can use File: Open directly on a template file to make changes
to a template and then save those changes. If you create a new song file with the
same name as one of the templates and save it, the template will be destroyed.

Can I add lyrics above a staff?
Yes, this is set in the Staff Lyrics dialog box (Ctrl+L). On the Configuration tab,
under Staff Placement, select Top for alignment. The lyrics will appear above
the active staff.

Why can I not change tempo for a *.mid file?
When a *.mid file is imported, it may include a Conductor Track that controls
the tempo and other global settings. This track will override the tempo changes
you make to the other staves. The Conductor Track will be in a different group
from the other staves and will appear as the last staff in the imported score. To
see if your file has a Conductor Track, use Tools: Score Review. This staff can
be edited to meet your needs, or you can delete it and insert the information into
the other staves.

How can I remove beams, slurs, dots, etc. from notes?
Once you have issued a command to assign a beam, triplet, slur, tie, etc. to
note(s), you can remove the item later without deleting the notes and starting
over. For example, to remove the beam from some notes, select the beamed
notes and press Ctrl+B or click the Beam icon. To remove the staccato mark on
a note, select the note and press the quick key, (comma) or click the Staccato
icon.
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How do I enter a trill, like in moonlite.nwc?
Trills are not yet supported in NoteWorthy Composer, but there is a work
around. The song moonlite.nwc in the NWC Samples folder uses Insert: Text to
show the symbol tr~~~ in the Standard Group top staff. The trill sound is then
notated in the Hidden Group top staff. Measure 30 is the first place the trill is
located in the song. The Standard group is for printing (and display). The
Hidden Group is for play back. Thus, while playing back the file and displaying
the Standard group, it looks as though the tr~~~ is playing back like a trill. To
see all of the staves, go to File: Page Setup, Contents and select all the staves.

To put staves in different groups like Standard and Hidden, etc. use Staff: Staff
Properties, General tab, enter name. See page 33 for more detail on groups.

For more information on work arounds for trills see our NWC User Tips and
Tricks web page at http://noteworthycomposer.com/usertips.htm

Is there an auto save feature?
There is an auto save/recovery feature in NoteWorthy Composer. You can
activate this feature and set the frequency (in minutes) in Tools: Options, File
tab. You can also have backup files automatically created. This is set on the
same tab.

Where do I set to end a staff with a Master Repeat Close?
Staff: Staff Properties, General tab, Ending Bar: Master Repeat Close. You can
also choose from other ending bars.

Why will my song file not print?
If your song file will not print, first make sure you have bar lines in the staves.
Second, make sure your bar lines align between staves. NoteWorthy Composer
relies on bar lines to start new lines on the print. To test the bar line alignment:
1- Make a copy of your song file, 2- Use Tools: Audit Bar Lines on each staff,
3- Find where the bar lines do not line up and note this, 4- Fix the problems in
your original song. If you have chords, the smaller duration in the chord is
counted for the measure count. Search the Help File for Chord Member
Command for more information. If your bar lines are in order and your song still
will not print, check the flow of your song. If NoteWorthy Composer cannot
follow the flow of the song it will not be able to print it and probably will not be
able to play it. See the Samples folder for examples of repeats, special endings,
segnos, etc. The files are repeatx.nwc where x is 1-4.



44 Common Questions

What is the import note resolution?
In Tools: Options, Import tab, the Note Resolution actually refers to the
sampling time. It is not the smallest note duration that will be imported. A small
value will allow complex sequences to be notated correctly. It will provide more
detail. A large value will simplify the resulting notation.

How do I set the location for saving my song files?
The Folders tab in Tools: Options allows you to set the folder accessed with
File: Open and File: Save. The default is the Samples folder. However, you
should change this so your song files are saved in a folder outside of the
program folder. This may be your documents folder or you may want to create a
music folder.

Can I put in the D for a time signature of 4/4 or the E for 2/2?
Yes. When you use Insert: Time Signature (quick key G), at the bottom of the
dialog box where it lists Standard Signature, select Common Time or Alla
Breve. You can also click the icon on the Insert tool bar for fast entry.

Why does my printer not print all that is in Preview?
Printers often have an unprintable area around the edges. If your margins are too
small, this can cause your print to get clipped. Increase the margins to fix it.

Can I lower the volume for some staves?
You can control the volume for each staff in Staff: Staff Properties, Midi tab,
Part Volume. 127 is the loudest, 64 is the middle setting and 0 is mute.
Therefore, if you need to focus on your instrument part or your vocal part, you
can lower the volume on the other staves. Once you are ready to practice with all
volumes equal, you can easily return all the volumes to 127.

How do I insert a clef that will play an octave up or down?
When you use Insert: Clef (quick key C), in the dialog box where Octave Shift is
set for None, change the setting to Octave Up or Octave Down.

How do I change the size of the staves for printing?
File: Page Setup, Options, Staff Size (in points) sets the size for printing.

Can I remove one note of a chord?
To remove one note of a chord, place the insertion point to the right of the note
that you want to remove and press Ctrl+Backspace.
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After I transpose, why do things not sound right?
This behavior is controlled by the "Update staff play back transposition"
checkbox in the Transpose dialog. When checked, the results after the transpose
will sound at the same pitch, even though you transposed. If you did not mean to
leave this checked, you can reverse the effect by going into Staff Properties
(F2), the Midi Tab, and changing the Transposition field to "+0" (example),
rather than the "+3" (example) that it was changed to after the Tools, Transpose
command was used.

With Staff Layering, how can I adjust the position of rests
and notes so they are not on top of each other?
Select the note or rest and press Alt+Enter. Under the Notes tab, you will be able
to adjust the spacing of the note and the vertical offset of the rest.

How can notes be printed with a different color?
Select notes and press Alt+Enter, on the Visibility tab, select one of the
Highlight colors. If you want the entire staff printed a different color, click the
staff, click the Visual tab, and under color, select one of the highlight colors. If
you want to change the color selection, go to Tools: Options, Color.

Is there a way to force a line break?
When entering a bar line with Insert: Bar Line (Decorated), you can select Force
System Break in the dialog box. To add a break at an existing bar line, select the
bar line, press Alt+Enter, and select Force System Break.

How do I set play to be over my MIDI keyboard?
To have NoteWorthy Composer play back over a MIDI Keyboard, make sure
you have the correct device for access to your keyboard selected in Tools:
Options, MIDI, Devices Used by play back. It should be the only device
selected. It depends on your equipment, but it may be named external something
or mpu something. If you do not have the device needed as a selection, then this
is not supported on your system or has not been installed correctly or at all.

How do I change the direction of a slur or tie?
Select the notes that are tied or slurred and press Alt+Enter. Under the Notes tab,
you will be able to select the direction to be upward or downward.
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How do I set up to use a MIDI keyboard with NWC?
1. Make sure your keyboard is MIDI capable.

2. Make sure the cables are connected correctly. Some systems like MIDI In to
MIDI In and some like MIDI In to MIDI Out. Even though there is a
standard some do it the opposite.

3. In NWC, Tools: Options, Record tab, make sure you have selected the In
Port of your sound card. (You may even want to go through each selection
and test).

4. Make sure you are following the proper procedures for MIDI keyboard
input. There are 2 ways to input notes with a MIDI keyboard. Live play will
record what you are playing with duration (page 27). Step play will enter
note pitches as you press keys without duration (page 27).

How are the devices chosen for Tools: Options?
The Available play devices under the MIDI tab and Input Device and play
device under the Record tab are listed based on the drivers that you have
installed on your computer for the equipment that you have. If you are trying to
play over a piece of equipment and the device is not listed, the driver to access
the equipment has not been installed or has not been installed properly.

To access some equipment, you may not be looking for the device name, but the
way you will receive information from that device. For example with recording,
you may set the device to the “in port of your sound card” as there would not be
a selection by the name of your MIDI keyboard.

With the Insert tool bar, why should I use the Insert menu?
Not all items are listed in the tool bar. For example the Tenor Clef is not shown,
but can be accessed with Insert: Clef.

Where can I find more *.nwc song files?
A great place to start is our NWC Registered Users' Music Pages web page. This
is at: http://noteworthycomposer.com/userlinks.htm

Where are the symbols for back to back repeats?
Go to Insert: Bar Line (Decorated) and enter the “close” for the bar line that you
want. Then enter the “open” for the bar line that you want The bar lines will
then be combined to look like one symbol.
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How can I get play back directed to my MIDI keyboard?
To have NoteWorthy Composer play back over a MIDI Keyboard, make sure
you have the correct device for access to your keyboard selected in Tools:
Options, MIDI, Devices Used by play back. It should be the only device
selected. The device name depends on your equipment, but it may be named
external something or mpu something.

If you do not have the device needed as a selection, then this is not supported on
your system or has not been installed correctly or at all.

How can I get more (or less) on a printed page?
Some of the items you can change to try and get the look you want include:

-File: Page Setup, Margins
-File: Page Setup, Options, Staff Size
-File: Page Setup, Options, Increase note spacing for larger....
-File: Page Setup, Fonts
-Staff: Staff Properties, Visual, Vertical Size
-Insert: Bar Line Decorated, Force System Break

What will I find at the NoteWorthy Software web site?
At the web site, there is a list of FAQ, User Tips, a Forum, links to user web
sites and much more. The address is http://noteworthycomposer.com

How do I ______________ ?
If you have not figured out how to do something, you may want to look at the
following commands:

 File: Page Setup with Contents, Options, Margins, Fonts and Preview tabs.

 Staff: Staff Properties with General, Visual and Midi tabs.

 Tools: Options with Color, Editor, File, Folders, Import, Midi and Record
tabs.

These commands include a lot of functionality that may help you.
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Notation Symbols
If you do not know the name of a symbol to enter it in NoteWorthy Composer,
the pictures below may help. The following symbols can be found in the Insert
menu. For additional help, symbols on the tool bars can be identified by moving
the insertion point over the icon and reading the tip that appears.

Clefs

Bar Lines (Decorated)

Key Signatures

Tempo Variance

I Breath Mark

y Fermata
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General MIDI Drum List
The table below lists the note pitches to use for various percussion sounds. See
page 20 for instructions on how to set up your song to play percussion sounds.

Note Pitch Percussion Sound Note Pitch Percussion Sound
B2 Acoustic Bass Drum B4 Ride Cymbal 2
C3 Bass Drum 1 C5 High Bongo
Db3 Side Stick Db5 Low Bongo
D3 Acoustic Snare D5 Mute High Conga
Eb3 Hand Clap Eb5 Open High Conga
E3 Electric Snare E5 Low Conga
F3 Low Floor Tom F5 High Timbale
F#3 Closed High Hat F#5 Low Timbale
G3 High Floor Tom G5 High Agogo
G#3 Pedal High Hat G#5 Low Agogo
A3 Low Tom A5 Cabasa
Bb3 Open High Hat Bb5 Maracas
B3 Low-Mid Tom B5 Short Whistle
C4 High-Mid Tom C6 Long Whistle
Db4 Crash Cymbal 1 Db6 Short Guiro
D4 High Tom D6 Long Guiro
Eb4 Ride Cymbal 1 Eb6 Claves
E4 Chinese Cymbal E6 High Wood Block
F4 Ride Bell F6 Low Wood Block
F#4 Tambourine F#6 Mute Cuica
G4 Splash Cymbal G6 Open Cuica
G#4 Cowbell G#6 Mute Triangle
A4 Crash Cymbal 2 A6 Open Triangle
Bb4 Vibraslap

The following staff section shows how a few of the percussion sounds would be
notated for play back:

Clap Bell Bongo Triangle
Hand Cow Low Mute

b f k C4      

d k
a dk C6      

d k  
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General MIDI Instrument List
The table below lists the patch number and name. These instruments are selected
with Insert: Instrument Patch (if your sound card supports General MIDI).

1. Acoustic Grand Piano
2. Bright Acoustic Piano
3. Electric Grand Piano
4. Honky-tonk Piano
5. Rhodes Piano
6. Chorused Piano
7. Harsichord
8. Clavinet
9. Celesta
10. Glockenspiel
11. Music Box
12. Vibraphone
13. Marimba
14. Xylophone
15. Tubular Bells
16. Dulcimer
17. Hammond Organ
18. Percussive Organ
19. Rock Organ
20. Church Organ
21. Reed Organ
22. Accordian
23. Harmonica
24. Tango Accordian
25. Acoustic Guitar (nylon)
26. Acoustic Guitar (steel)
27. Electric Guitar (jazz)
28. Electric Guitar (clean)
29. Electric Guitar (muted)
30. Overdriven Guitar
31. Distortion Guitar
32. Guitar Harmonics
33. Acoustic Bass
34. Electric Bass (finger)
35. Electric Bass (pick)
36. Fretless Bass
37. Slap Bass 1
38. Slap Bass 2
39. Synth Bass 1
40. Synth Bass 2
41. Violin
42. Viola
43. Cello

44. Contrabass
45. Tremolo Strings
46. Pizzicato Strings
47. Orchestral Harp
48. Timpani
49. String Ensemble 1
50. String Ensemble 2
51. SynthStrings 1
52. SynthStrings 2
53. Choir Aahs
54. Voice Oohs
55. Synth Voice
56. Orchestra Hit
57. Trumpet
58. Trombone
59. Tuba
60. Muted Trumpet
61. French Horn
62. Brass Section
63. Synth Brass 1
64. Synth Brass 2
65. Soprano Sax
66. Alto Sax
67. Tenor Sax
68. Baritone Sax
69. Oboe
70. English Horn
71. Bassoon
72. Clarinet
73. Piccolo
74. Flute
75. Recorder
76. Pan Flute
77. Bottle Blow
78. Shakuhachi
79. Whistle
80. Ocarina
81. Lead 1 (square)
82. Lead 2 (sawtooth)
83. Lead 3 (caliope lead)
84. Lead 4 (chiff lead)
85. Lead 5 (charang)
86. Lead 6 (voice)

87. Lead 7 (Fifths)
88. Lead 8 (bass + lead)
89. Pad 1 (new age)
90. Pad 2 (warm)
91. Pad 3 (polysynth)
92. Pad 4 (choir)
93. Pad 5 (bowed)
94. Pad 6 (metallic)
95. Pad 7 (halo)
96. Pad 8 (sweep)
97. FX1 (rain)
98. FX2 (soundtrack)
99. FX3 (crystal)
100. FX4 (atmosphere)
101. FX5 (brightness)
102. FX6 (goblins)
103. FX7 (echoes)
104. FX8 (sci-fi)
105. Sitar
106. Banjo
107. Shamisen
108. Koto
109. Kalimba
110. Bagpipe
111. Fiddle
112. Shanai
113. TinkerBell
114. Agogo
115. Steel Drums
116. Woodblock
117. Taiko Drum
118. Melodic Tom
119. Synth Drum
120. Reverse Cymbal
121. Guitar Fret Noise
122. Breath Noise
123. Seashore
124. Bird Tweet
125. Telephone Ring
126. Helicopter
127. Applause
128. Gunshot
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Note Positions and Names

Various Music Duration Names

American English Medieval
Whole Semibreve Semibrevis
Half Minim Minima
Quarter Crotchet Semiminima
Eighth Quaver Fusa
Sixteenth Semiquaver Semifusa
Thirty-second Demisemiquaver --
Sixty-fourth Hemidemisemiquaver --

Support for NoteWorthy Composer
For support in using NoteWorthy Composer, you may contact us via:

E-mail support@NoteWorthyComposer.com
Web http://NoteWorthyComposer.com
Mail NoteWorthy Software, Inc.

PO Box 995
Fuquay-Varina, NC 27526-0995
USA


